Seradex OrderStream
Technical Release Notes
April 2019
AcctMaintenance.dll

6.4.104

05/10/2019

I1902175

Added Address lines 3 & 4 to the Ship To Lookup accessed through the
binoculars button on the Estimate and Sales Order forms.

05/10/2019

I1905103

An issue where launching inventory allocation from Vendor Returns causes
an error about a ContainerNo field has been resolved.

I1809029

Added ability to sync Custom Report files between OrderStream and DBOX.

I1810245

Avoid saving of named ranges setup in Runtime and Initial Data Imports
when the named range already exists in the workbook. Just resize it.
Implemented support for Freight and Handling items configured from DBOX
in Order Stream

ActiveM20.dll

6.4.122

AdminTools.dll

6.4.56

04/30/2019

AutoConfig.dll

6.4.106

05/10/2019

I1903130

Config.dll

6.4.174

05/10/2019

I1903130
I1810245
I1903047
I1903044
I1904067

I1903260
I1905028

I1904270

Implemented support for Freight and Handling items configured from DBOX
in Order Stream
Avoid saving of named ranges setup in Runtime and Initial Data Imports
when the named range already exists in the workbook. Just resize it.
Implemented single excel filtered property value defaulting in order stream
configurator.
Config and the Packaging Distribution form have been modified to track and
support leading zeroes specified in the StartNo field.
As part of issue I1810245 - (Config Runtime Data Import) the read only
preference check before importing initial data to the workbook was removed..
The ReadOnly preference is only checked a range name that does not
already exist in workbook is configured to be created and saved.
Updated to evaluate starting number in Output worksheet as a string value.
The system will now allow a maximum of a 30 character string.
Corrected the problem where the header due date of the Sales Order was
not being updated after the user clicks "Yes" to the prompt that asks to
override it when updating the Sales Order line from the Configurator.
Modified to ensure that when saving a configuration, the formulas in the
"Order UOM" and "Priced UOM" cells of the Excel configurator Output sheet
are not replaced by fixed values.

DataTransfer.mdb

1

Seradex OrderStream
Technical Release Notes
April 2019
6.4.240

04/30/2019

I1810205
I1904058
I1903236
I1809029

I1903082
I1902215

I1902237

I1903004
I1901020
I1903077

I1901321

New advanced security option to edit Description of work comments on
approved description of works
Updated the Core Telerik Reports to be accessible through DBOX.
Added security options to hide the Convert Prospect to Customer
functionality in CRM
Modified the core reports of DBOX to use the Transaction Number to filter
the Report instead of the ID. Also modified the Reports to all use the same
crTaxSubReport.
Added security options for the Customer Notes card added in DBOX.
Added CustRefNo as a field to all the possible Core DBOX Searches. This
includes: Estimate, SalesOrder, Shipments, Payments, Invoices, Credit
Notes, Opportuinities, and Service Desk
Removed old expired commands for creating assemblies and certificates and
added new ones that use a valid certificate for both the master database and
the ActiveM.
Removed the Dashboards menu option from Dbox and moved it's sub-items
into BI Reporting. Changed the name of Chart config to Chart Editor.
Added localization values for the Sell Items maintenance grid on the Web
Category Maintenance page.
Modified "Order Name" in the Estimate Header to read "Estimate Name" by
default. Modified "Order Info" in the Estimate Header to read "Estimate Info"
by default.
In DBOX, on the CRM Lists
Leads will now filter for Sales Reps where they are the Sales Rep for the
Customer/Prospect on the lead OR where their Employee record is the
EmployeeID on the Lead.

I1901320
I1811270
I1904216
I1904152
I1904083

6.4.241

05/10/2019

I1903314
I1903260
I1501100

I1810322

Activities will now filter for Sales Reps where they are the Sales Rep for the
Customer/Prospect on the activity OR where their Employee record is the
EmployeeID on the Lead.
Sales Order and Invoice searches in DBOX now only show for Sales Reps
when they are the SalesRep associated to the Sales Order/Invoice.
Added queries required for the Data Collection Splitter enhancement.
Alter GL Inventory Audit Search to show standard costs for inventory if the
company is not using actual costing
Added the 2 require fields for the intercompany search and view.
Altered report dialog for the Core remittance to let you select by date first
then bank transaction.
Added Better Security to the Security Management page.
The InventoryConversionOrder's StartNo field has been modified. StartNo is
now stored as nvarchar to provide additional characters.
Added a new table to store the crew size (CalendarCrewSize), and
transfered the existing crew size data from the CalendarData and
ToBeScheduled_InProgress tables to the CalendarCrewSize table.
Removed the CrewSize field from the CalendarData table.
Added indexes to POInvoice and PoInvoicePaymentDetails to improve
improvement of financial modules such as Pay vendor invoices
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DBOX 3rd Party Components

6.4.1

04/30/2019

I1902169
I1903034

Upgraded the Angular Material CSS to the proper version to match with our
Angular Material JS
Made some corrective actions against some display issues in DBOX after
upgrading to Angular Material 1.1.4

DBox Web Front End Components (WFE)

6.4.18

04/30/2019

I1903040
I1903034
I1903079
I1903039
I1903082

I1901020

I1903128

I1903077

I1903148
I1903193

I1903236
I1902169
I1811301
I1811304
I1811285
I1902264
I1902014

Fixed an issue where a few fields in the Estimate/Sales Order header would
not display correctly in Firefox/Edge.
Decreased the default font size in DBOX from 14px to 13px
Modified the Transaction Groups to exclude Shipping + Handling from the
group qty and qty ordered.
Converted the Child configurations in Configurator type 4 to be a grid view.
This will allow for quicker editing of property values for child items.
Added a card to display the Customer's notes on the Estimate/Sales Order
page. This will only show for non-customer users such as Employees,
WebAdmin, SalesRep, UnfilteredSalesRep. And OutsideSalesReps (Vendor
Contacts). CustomerTeam and CustomerAdmin users can never see the
card.
Modified the Web Category Maintenance to allow easier adding and
removing of Sell Items from Web Categories. You can now bulk add/remove
items.
Removed the "Transaction Group" grouping from the Estimate/Sales Order
pages. Items will now only be separated into sub-groups if they are a
Parent/Child Configuration.
Modified Estimate, Sales Order and Invoice to properly display Entry Date vs
Order Date. Also changed the caption on the Header to say Estimate Info vs.
Order Info depending on whether you are looking at an Estimate vs Sales
Order/Invoice.
Fixed an issue where links to reset passwords and register users with DBOX
would incorrectly bring the user to the Home Page.
Fixed an issue where if a transaction (Estimate/Sales Order) was not saved
and you selected "Change Ship To" and created or chose another ship to it
would not redirect back to the create transaction page with the proper
Customer/Ship To selected.
Added security options to hide the Convert Prospect to Customer
functionality in CRM
Fixed some issues where tooltips wouldn't appear. Fixed some general
display issues with Angular Material.
Modified the Chart Configurator to show errors in the same manner as the
rest of the site for consistency.
Added a toast to inform the user that using a chart with a large amount of
records may cause the Chart Editor to take a few seconds to load.
Performance enhancements for Internet Explorer 11/Edge/Firefox.
Fixed a few issues with authentication in DBOX and some display issues with
the configurator caused by an upgrade in Angular Material
Discount is no longer a field on the "Add Sell Items To Order" page. The
Price is no longer editable on the "Add Sell Items To Order" page.
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6.4.18

04/30/2019

I1803178

I1901201

I1901194
I1903004
I1903314
I1903313

Modified "Upload Sheet" in the Admin panel to now say "Manage
Worksheets". Can now see which Product Lines have an existing config
sheet in Cloud Storage and can Download the Config Sheets and view the
date they were last uploaded. On the Display Category Maintenance you can
also download the existing Sheet in Cloud Storage.
Modified Document Approval to open in a modal window. Fixed an issue
where adding mutiple approvers would fail. Added the ability to remove
approvers. Fixed an issue where the Line Number wasn't showing in the
Document Approval window. Removed the Save button, everything saves
automatically.
Fixed an issue where users would not be able to get to the Set/Reset
Password pages when opening the link in a new tab/window.
Added a Company Dashboard hidden menu option.
Added Better Security to the Security Management page.
Certain Inputs and Dropdowns inside toolbars will no longer blend in with
their background

DC2001.dll

6.4.50

05/09/2019

I1903309

I1811270

I1904229

Improved approval validation for data collection to ensure that the data
collection records will not be approved if necessary GL Accounts are missing.
Improved the management of temp tables to prevent running into the
scenario where the system cannot make additonal tables.
Added the data collection splitter form, accessible through the Tools menu in
Data Collection. This form is used to intelligently divide the hours of a data
collection record by data driven logic to apply them to previously completed
work orders.
The Data Collection form will now always validate entered Work Centre
values before accepting it.

Estimating.dll

6.4.160

05/10/2019

I1810291

The SalesTracker tab in Estimate and SalesOrder will now respond to
advanced security settings allowing its controls to remain editable when its
parent document has been approved.

I1501100

Release Infragistics 2013.1 file Infragistics4.Win.Misc.v13.1.dll to LAN.

I1903270

Enhanced to support filtering Container Management inventory items using
module transaction detail items.
Enhanced to support filtering Container Management inventory items using
module transaction detail items

Infragistics4.Win.Misc.v13.1.dll

6.4.1

05/10/2019

InventoryTransfer.dll

6.4.91

05/10/2019

I1901274
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Invoice.dll

6.4.157

05/10/2019

I1904034

I1905027

I1905016
I1810024

The Invoice Edit Freight form has been modified. Validation has been
improved. If rows are found to be invalid on save, a message will now inform
the user of which line must be fixed. Users can now make and save changes
to the selling and actual unit costs of freight rows, including when the freight
row has an associated shipment or sales order.
Adjusted the logic to ensure that when the system is removing remaining
inventory, the system is not looking at containers that is allocated to the
shipping or invoice details.
Location GL Accounts will now be used as the Inventory GL Account when
the UseLocationGLAccount company preference is on.
Ensure For Deposits against Jobs if there is a ship to on the Job to use that
ship to for the invoice

JobCosting.dll

6.4.81

05/10/2019

I1810024

I1905099
I1810205

Added validation for Job Billing only on approval to ensure a Ship to is
selected and improved the validation on approval to ensure at least one
description of work exists as well as all being approved.
Approved job costing documents will now display work flow data saved
against them.
Added ability for advanced security to edit the comment portion of a
description of work if approved

MatReq.dll

6.4.124

05/10/2019

I1904124

I1904226

When calculating MRP sales order demand, the final number will now be
rounded based on the client's Purchase Order specific rounding units to
prevent rounding and floating-point fractional anomalies.
Modified to ensure that the MRP logic always correctly calculates the
demand of parent work orders under a very specific scenario where some of
the sub work orders are already fully completed.

POInvoice.dll

6.4.105

04/26/2019

I1904070

Altered PO Invoice to prevent users from deleting the value in the Extended
Cost field on the miscellaneous tab.

05/09/2019

I1901228

Formatted the Item and Cat fields of the Input worksheet as General instead
of Date.

I1904140

The Vendor Price List can now be accessed from the View menu in .NET
Purchase Order when the AdvancedPO module is activated.

PriceList.xls

6.4.3

PurchaseOrder.dll

6.4.124

05/09/2019
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6.4.124

05/09/2019

I1904143

Ensured that existing WO, Line No, and SO load correctly onto the PO under
all conditions.

I1810291

The SalesTracker tab in Estimate and SalesOrder will now respond to
advanced security settings allowing its controls to remain editable when its
parent document has been approved.
Container Management menu has been added to the SalesOrder Tools'
menu.
The account number box on the Sales Order form will now clear its text
whenever the freight vendor combo box is cleared.
An issue where a foreign key error could occur when trying to generate a
work order from a sales order with an associated job costing record when all
necessary inventory has already been allocated to the sales order has been
resolved.
Removed obsolete and inaccessible logic from the system. Work Order
Generation has been improved to ensure generating through the menu
option or approval behaves the same.
Location GL Accounts will now be used as the Inventory GL Account when
the UseLocationGLAccount company preference is on.

SalesOrder.dll

6.4.202

05/10/2019

I1901274
I1902268
I1904276

I1904266

I1905016

Seradex.BaseSystem.dll

6.4.38

05/10/2019

I1501100
I1904214

Modified to provide generic functionality used when saving the calendar crew
size data from scheduling to a new table.
Altered launching reports from newer Modules to ensure any custom or core
report that is done in Telerik appears in front of the calling screen

Seradex.CommonServices.dll

6.4.49

04/30/2019

I1809029

Added ability to communicate with web APIs/services.

I1905090

The ActiveM connection has been enhanced such that classes may now
protect the connection from being destroyed until desired.

I1810245

Updated the Runtime Data Import functionality to properly handle data types
returned from the database.
Fixed an issue where copying transaction groups that contained sell items
would fail.
Added the ability to remove an approver from document approval
Sell items will now load their price from the PriceList.xls if applicable on the
"Add sell items to order" page.

Seradex.Connection.dll

6.4.39

05/10/2019

Seradex.Dbox.dll

6.4.19

04/30/2019

I1902192
I1901201
I1902014
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6.4.19

04/30/2019

I1803178

I1809029
I1902020

I1903082
I1903193

I1903266

I1901020

I1902214
I1904145
I1904099
I1904062

I1903126
I1904065

Added ability to locate all the Config Sheets in Amazon Storage and map
their URL to their Product Lines for maintenance in the Display Category
Setup and "Upload Sheet" forms.
Added ability to sync Custom Report files between OrderStream and DBOX.
This issue has been corrected in the release code as critical and checked
into TFS. Please re-release as early as possible.
Fixed issue where DBOX Genkey generates additional number in key
Customer Notes will now load into the Sales Order/Estimate information for
non-customer users.
Fixed an issue where Ship To creation would automatically set the new Ship
To as the Default Customer Ship To. Also fixed an issue where DBOX would
not create a Ship To record on Prospect Creation.
Corrected DBOX. Ensured that the customer account set is validated in sales
order and estimate conversion to sales order. Also ensured that the field is
saved to the database in sales order.
Modified the way we retrieve the list of Sell Items for the Web Category
Maintenance page. They will now properly be sorted by Item No by default,
and we've include a few more fields such as Routing, Revision, and
Category.
Fixed an issue where the Entry Date would not be filled in by DBOX when
creating an Estimate/Sales Order.
DBOX Configurator Group Visibility
Updated DBOX to correctly update the NewItemNo field in ConfigBatch
Added a couple custom functions to the API for Banknote and their User
Defined Part Numbers. Also added a simple call to validate whether an
ItemNo exists.
Improved DBOX item configuration performance
Modified DBOX to check the configurator preference before attempting to
master an item.

Seradex.EstimateSystem.dll

6.4.2

05/10/2019

I1904213

.NET Estimate - Added a messagebox to confirm editing a detail's Qty
Ordered on configured details, to match with SO and VB6.

I1904140

Added the capability of opening excel and viewing the current document for
certain .NET classes.

I1810291

Modified the SecuredControlService to be able to handle making the types of
controls in the SalesTracker tab not-ReadOnly.
Minor optimizations.

Seradex.Excel.dll

6.4.17

05/09/2019

Seradex.Infragistics.dll

6.4.34

05/10/2019

I1905053

Seradex.Inventory.dll
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6.4.26

05/10/2019

I1903270

The container combo will now be sorted by Container No.

I1904239

.NET Invoice will now prompt the user if they would like to add any remaining
non shippable items from the related sales order when a new invoice is
generated from a shipment.

Seradex.InvoiceSystem.dll

6.4.7

04/25/2019

Seradex.Production.Calendar.dll

6.4.16

05/10/2019

I1501100
I1802172
I1805038

Modified to save the crew size in a new table.
Calendar Setup has been modified to ensure a Calendar's BaseCalendar is
saved when changed.
Can now open a date in a calendar that is marked as closed in its base
calendar.

Seradex.Production.DataCollection.dll

6.4.46

05/09/2019

I1811270

I1903309

Added the data collection splitter form, accessible through the Tools menu in
Data Collection. This form is used to intelligently divide the hours of a data
collection record by data driven logic to apply them to previously completed
work orders.
Improved approval validation for data collection to ensure that the data
collection records will not be approved if necessary GL Accounts are missing.
Improved the management of temp tables to prevent running into the
scenario where the system cannot make additonal tables.

Seradex.Production.Scheduling.dll

6.4.73

05/10/2019

I1701161
I1501100

The load time has been reduced for clients with large amounts of scheduling
data.
Modified to store the crew size in a new table (CalendarCrewSize).

Seradex.Purchasing.dll

6.4.11

05/09/2019

I1904140
I1904143
I1905005

The Vendor Price List can now be accessed from the View menu in .NET
Purchase Order when the AdvancedPO module is activated.
Ensured that existing WO, Line No, and SO load correctly onto the PO under
all conditions.
LineNo will now be written to the database for purchase order details.

Seradex.Purchasing.ReceivingSystem.dll

6.4.15

04/17/2019

I1904162

Corrected issue with received unit cost and the received stock cost being
rounded to the nearest integer.
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6.4.15

04/17/2019

I1904112

6.4.16

05/10/2019

I1905103

Added a new message box to Receiving to inform users that inventory
cannot be created when the receipt is associated to a drop shipped PO,
unless 'Receive Customer Inventory to Stock is checked'.
An issue where launching inventory allocation from Vendor Returns causes
an error has been resolved.

Seradex.RecurringTransaction.dll

6.4.15

05/09/2019

I1808133
I1903168

Modified the Progress Payment Setup form to better handle non-numeric
values in the Retention Ratio and Max Retention Rate textboxes.
Progress Payment rate fields cannot be saved as NULL any longer.

Seradex.RestApi.dll

6.4.15

04/30/2019

I1904062

I1809029
I1902057
I1803178

I1902014
I1901201

Added a couple custom functions to the API for Banknote and their User
Defined Part Numbers. Also added a simple call to validate whether an
ItemNo exists.
Added ability to sync Custom Report files between OrderStream and DBOX.
Removed some old folders that were from previous project references. This
should have no effect.
Added ability to locate all the Config Sheets in Amazon Storage and map
their URL to their Product Lines for maintenance in the Display Category
Setup and "Upload Sheet" forms.
Sell items will now load their price from the PriceList.xls if applicable on the
"Add sell items to order" page.
Added the ability to remove an approver from document approval

Seradex.SalesOrderSystem.dll

6.4.6

04/18/2019

I1904203

Product Lines will recalculate their totals when modifying the Qty Ordered on
.NET Sales Order

An issue where the decimal values on Shipping details may not translate to
the generated Invoice has been resolved.
An issue where the header could break during load of shipments has been
resolved.
Additionally, customer ship to information will now be read from the Sales
Order when generating shipping details.
The value of Qty On SO will now default to 0 instead of null.

Seradex.Shipping.dll

6.4.5

05/01/2019

I1904313

6.4.6

05/09/2019

I1905018

Seradex.Win.Configurator.dll

6.4.4

05/09/2019

I1905025

Updated for compatibility with the latest Seradex.ConfiguratorSystem.dll file.
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Seradex.Win.Estimate.dll

6.4.9

05/10/2019

I1905053
I1904213
I1904141

I1810291

An issue was fixed where secured controls could be set from a default
database or cause an error in a multicompany environment.
.NET Estimate - Added a messagebox to confirm editing a detail's Qty
Ordered on configured details, to match with SO and VB6.
Resolved an issue where an error would occur if the user tries to save their
view settings in .NET Estimate/Sales Order, and their currently set view does
not exist in the database. This could occur if it was set by a different
database, or deleted from the server.
The SalesTracker tab in Estimate and SalesOrder will now respond to
advanced security settings allowing its controls to remain editable when its
parent document has been approved.

Seradex.Win.Financials.dll

6.4.102

05/10/2019

I1904214

Corrected issue running core cheque reports whereby the cheque did not
appear on the screen but was hidden temporarily.

Seradex.Win.InventoryTransfer.dll

6.4.17

05/10/2019

I1901274
I1903270

A new checkbox has been added to Container Management allowing the
system to filter the inventory items using the transaction details item.
A new checkbox has been added to Container Management allowing the
system to filter the inventory items using the transaction details item.

Seradex.Win.Invoice.dll

6.4.20

05/10/2019

I1904035
I1904055

Edit Freight has been added to .NET Invoice.
Invoice and Credit Note have been modified to use Read Only instead of
Enabled when the form is in a disabled state, allowing for better readability as
well as copying.

Seradex.Win.OrderEntryFormLibrary.dll

6.4.1

05/10/2019

I1903045
I1903044
I1903260

The Packaging distribution form has been modified to highlight any package
rows that are associated to the currently selected shipto address.
Config and the Packaging Distribution form have been modified to track and
support leading zeroes specified in the StartNo field.
Packaging Distribution has been modified to handle and generate StartNo
and EndNo values of up to 50 characters. (StartNo of 30, plus 10 maximum
for suffix and prefix each.)

Seradex.Win.Purchasing.dll

6.4.26

05/09/2019

I1904140

The Vendor Price List can now be accessed from the View menu in .NET
Purchase Order when the AdvancedPO module is activated.
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6.4.26

05/09/2019

I1904143
I1905005

Ensured that existing WO, Line No, and SO load correctly onto the PO under
all conditions. Ensured that pairs of WO and SO are always enforced.
LineNo will now be written to the database for purchase order details.

Seradex.Win.Receiving.dll

6.4.23

05/10/2019

I1905103

An issue where launching inventory allocation from Vendor Returns causes
an error has been resolved.

Seradex.Win.RecurringTransaction.dll

6.4.16

05/09/2019

I1903168
I1812168

I1808133

Progress Payment rate fields cannot be saved as NULL any longer.
The Ratio column of the Progess Payments Setup form will now have a zero
value by default, and insist on having a numeric value if the user deletes the
default.
Modified the Progress Payment Setup form to better handle non-numeric
values in the Retention Ratio and Max Retention Rate textboxes.

Seradex.Win.SalesOrder.dll

6.4.11

04/18/2019

I1904071
I1904091

6.4.12

05/10/2019

I1904179
I1904141

I1901274
I1810291

I1904004
I1902268
I1905090
I1904276

I1904266
I1905053

.NET Sales Order - Changing the Ship To updates the Freight Vendor
Account on Additional tab.
Cabinet vision is now manually garbage collected after running to prevent
errors on reload.
Users may now enter a negative Unit List Price on Sales Order.
Resolved an issue where an error would occur if the user tries to save their
view settings in .NET Estimate/Sales Order, and their currently set view does
not exist in the database. This could occur if it was set by a different
database, or deleted from the server.
Container Management menu has been added to the SalesOrder Tools'
menu.
The SalesTracker tab in Estimate and SalesOrder will now respond to
advanced security settings allowing its controls to remain editable when its
parent document has been approved.
The loaded sales order will now be reloaded upon return from the
DriveWorks import utility.
The account number box on the Sales Order form will now clear its text
whenever the freight vendor combo box is cleared.
Sales Order will now prevent any connection errors from occuring during its
lifetime.
An issue where a foreign key error could occur when trying to generate a
work order from a sales order with an associated job costing record when all
necessary inventory has already been allocated to the sales order has been
resolved.
Work Order Generation has been improved to ensure generating through the
menu option or approval behaves the same.
An issue was fixed where secured controls could be set from a default
database or cause an error in a multicompany environment.
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Seradex.Win.Scheduling.dll

6.4.42

05/10/2019

I1501100

Crew Size can now be modified and saved on days that have no scheduled
drums.

Seradex.Win.Scheduling.Finite.dll

6.4.22

05/10/2019

I1501100
I1701161

Crew Size can now be modified and saved on days where no operation
starts.
A calendar view has been added to finite scheduling.

Seradex.Win.Shipping.dll

6.4.10

04/26/2019

I1904299
I1904303

6.4.11

05/09/2019

I1905018

Validation to determine whether or not a shipment is over-shipping has been
corrected.
Resolved issue where Shipping could produce an error if a detail's shipto
address is changed from Edit Ship To.
An issue where the header could break during load of shipments has been
resolved.
Additionally, customer ship to information will now be read from the Sales
Order when generating shipping details.
The value of Qty On SO will now default to 0 instead of null.

Seradex.Win.Telerik.dll

6.4.15

04/30/2019

I1809029

Added ability to interrogate custom Telerik report files to determine what
subreports they contain.

05/10/2019

I1903270

Shipping will now pass the sales order ID to the Container Management for
to display inventory associated to the linked sales order.
Enhanced the container logic to support allocation container inventory to
sales order.
Location GL Accounts will now be used as the Inventory GL Account when
the UseLocationGLAccount company preference is on.
Adjusted the logic to ensure that when the system is removing remaining
inventory, the system is not looking at containers that is allocated to the
shipping or invoice details.

Shipping.dll

6.4.147

I1901274
I1905016
I1905027

sxMaintenance.dll

6.4.130

05/10/2019

I1903046

Added deletion validation on the Package / Holder Maintenance form. If any
related records are found when attempting to delete, the user will be
informed and the deletion will be cancelled.
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Template.xls

6.4.13

05/10/2019

I1903023
I1903044

COMMISSIONOUTPUTLAST excel defined name has been added to the
Output sheet.
Changed StartNo to text to allow for longer values of StartNo

WorkOrder.dll

6.4.180

05/10/2019

I1904224

I1902106

Work Order Completion has been modified to ensure the system tracks the
lifetime of the labour items temp table more precisely, to help prevent it from
being accessed when it no longer exists.
The work order validation procedure that runs upon saving the order has
been modified to check for ordered quantity changes that can put the
ordered quantity value equal to the quantity already completed when there is
still inventory allocated to the line.
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